
ESTUDO DE TRANSFERÊNCIA DE CALOR USANDO O ABAQUS 6.12 

STUDENT EDITION – CHAMINÉ COM VARIAÇÃO DE TEMPERATURA 

INTERNA E EXTERNA 

 

1. INTRODUÇÃO 

 

1.1. DESCRIÇÃO DO PROBLEMA: 

  

O Método dos Elementos Finitos aplicado à solução de problemas 

de campo 

 

Durante o processo de solução de muitos problemas em Engenharia 

recai-se na solução de problemas de campos potenciais. Tais campos são 

governados pelas equações de Laplace e Poisson, podendo citar entre eles os 

problemas de condução de calor, distribuição do potencial elétrico ou 

magnético, fluxo em meios porosos, fluxo irrotacional de fluidos ideais, torção 

de barras prismáticas além de outros. Este tipo de problemas obedece a 

seguinte equação:  

      

 onde o escalar Φ é conhecido como potencial escalar. Tal campo é 

conhecido como campo conservativo e, portanto, teremos:  

 

 Que demonstra que tal potencial escalar satisfaz a equação de Laplace. 

O estudo de campos de fluidos incompressíveis irrotacionais e campos 

gravitacionais são dois fenômenos para os quais o desenvolvimento acima, 

envolvendo a solução da equação de Laplace se aplica e trataremos de 

estudar um deles em detalhes: o problema de condução de calor em regime 

estacionário.  

Com relação às condições de contorno que podem aparecer em 

problemas potenciais, podemos subdividi-las em Condições de Contorno de 

Dirichlet, Neumann e Cauchy, ou ainda, de primeira, segunda e terceira 

espécie, respectivamente. Para problemas submetidos a condições de 



contorno de Dirichlet, o valor do potencial é especificado na fronteira δB, ou 

seja:  

Φ = g em δB 

A especificação da voltagem no contorno no caso de um campo de condução 

elétrica e da temperatura no caso de um campo de condução de calor são 

exemplos desta condição de contorno. Na condição de contorno de Neumann a 

derivada normal do potencial é especificada no contorno, ou seja: 

 

Condição de contorno cinemática de um campo de fluidos, no qual a 

componente normal da velocidade do fluido na fronteira deve ser igual à 

velocidade da fronteira é um exemplo da condição de contorno de Neumann. A 

condição de contorno de Cauchy ocorre quando o potencial e sua derivada 

normal obedecem a uma relação na forma: 

 

Tipicamente, esta condição ocorre quando existe uma camada resistente no 

contorno, como, por exemplo, quando existe uma camada metálica na fronteira 

no problema de condução de calor. 

 

Problema da transferência de calor 

 

Estamos interessados em determinar a distribuição de temperatura em 

um determinado sólido B. Em geral, as equações que governam a distribuição 

de temperaturas, tensões e deformações são acopladas, quer dizer, estas 

variáveis estão inter-relacionadas e devem ser determinadas simultaneamente. 

No entanto, em numerosos problemas práticos, a influência da tensão e 

deformação na distribuição de temperaturas é bastante pequena e geralmente 

pode ser deixada de lado. Desta maneira, quando da análise de um problema 

de tensões-deformações com efeitos térmicos, podemos como primeiro passo 

determinar, independente de outras variáveis a temperatura considerando o 

sólido como rígido. O segundo passo consistirá em determinar a distribuição de 



tensões e deformações no sólido quando submetido aos efeitos mecânico e 

térmico, sendo este último já conhecido. 

 

Mecanismos de transferência de calor  

 

Antes de abordarmos o problema de transferência de calor, devemos nos 

recordar que a energia calorífica se transfere de uma partícula para outra de 

uma certa matéria quando estas se encontram a diferentes temperaturas. Estas 

duas partículas podem ou não fazer parte de um mesmo sólido ou de um 

mesmo fluido, dependendo do sistema considerado. Teoricamente neste 

sistema deveríamos incluir não apenas o corpo em estudo, mas também todo o 

meio que o rodeia. Do ponto de vista prático, sempre será possível detectar 

uma região fechada de forma que a influência de todo o meio exterior possa 

ser deixada de lado. O mecanismo através do qual a transferência de calor se 

realiza entre as partículas depende da natureza (material) do sistema assim 

definido e mais especificamente da característica do material e do meio Método 
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ambiente em que estas partículas se encontram. Podemos assim distinguir 3 

modos de transferência de calor: condução, radiação e convecção. 

 

Condução: entre duas partículas de um corpo sólido que estão a diferentes 

temperaturas, o calor se transfere através de condução, processo que tem 

lugar a nível atômico e molecular. A lei linear de condução de calor será dada 

por:  

q = -K.Δ.θ 

onde:  

K é o tensor de condutividade térmica;  

Φ é o operador gradiente;  

Θ é a temperatura;  

q é o vetor fluxo de calor.  

Em particular, a densidade de fluxo por unidade de superfície de normal n será 

dada por: 

q = q.n = -K.Δ.θ.n  



Sendo que q(P) nos indica a quantidade de calor que passa no ponto P por 

unidade de superfície orientada segundo a normal n. Observa-se que se 

q(P)<0 indica que está sendo retirada energia calorífica da parte do corpo 

limitado pela superfície normal. Esta lei foi estabelecida por Fourier baseada 

em observações elementares e atualmente podemos obtê-la por aplicação dos 

Princípios da Termodinâmica; 

 

Radiação: se as partículas que trocam calor estiverem separadas por vazio, a 

transferência de calor não poderá se realizar através de condução, mas sim por 

radiação. Se as partículas estão separadas por um meio material também 

ocorrerá radiação, porém se este meio é um sólido ou um fluido esta radiação é 

desprezível. Já não ocorre o mesmo se o meio é um gás quando a 

transferência de calor por radiação pode ser importante. Algumas exceções 

ocorrem em sólidos como o quartzo e o vidro. 

 

Convecção: Como vimos, em um fluido a transferência de calor se produz 

através dos mecanismos de condução e radiação, sendo em geral, o primeiro 

mecanismo predominante. Porém, se o fluido está em movimento ocorre um 

incremento na transferência de calor em virtude de porções deste fluido 

estarem a diferentes temperaturas mesmo que suficientemente próximas. 

Quando o movimento do fluido se deve exclusivamente à diferença de Método 
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densidade pela diferença de temperatura, o processo é chamado convecção 

natural. Se o movimento do fluido se efetua por outro mecanismo, se chama 

convecção forçada. 

 

Condução de calor em regime estacionário 

 

 Seja um corpo ocupando a região limitada e regular B do espaço 

euclidiano tridimensional pontual ξ, com densidade de energia calorífica r por 

unidade de volume prescrita ao corpo por radiação, com temperatura prescrita 

θ na fronteira ∂Bθ com densidade de fluxo de calor q prescrita ao corpo por 

unidade de superfície ∂B-∂Bθ 

Pretende-se encontrar o campo de temperaturas q para o qual: 



 

Onde é válida a seguinte equação constitutiva:  

 

Determinação do campo de temperaturas 

 

Pretende-se com este exemplo estudar a variação de temperatura em 

uma chaminé industrial constituída de um material que possui condutividade 

térmica de k=1.4W/m.K, como mostra a figura abaixo. A temperatura interna é 

Tg=100ºC enquanto a temperatura externa é Ta=30ºC com um coeficiente 

h=20W/m².K. 

 

Figura 1. Esquema da chaminé a ser analisada 

 

 

1.2. PROPRIEDADES GEOMÉTRICAS 

 

Como na figura:  

a = 0.6 m 

b = 0.2 m 



1.3. PROPRIEDADES DO MATERIAL 

 

Condutividade térmica = k = 1.4 W/m.K 

Coeficiente de transferência térmica = ho = 20 W/m².K 

Temperatura interna = Tg = 100ºC = 373.15 K 

Temperatura externa = Ta = 30ºC = 303.15 K 

 

2. RESOLUÇÃO 

 

O procedimento de resolução pode ser demonstrado no seguinte 

fluxograma (a ordem pode eventualmente ser quebrada em pontos específicos 

por conveniência): 

 



 

PRÉ-PROCESSAMENTO 

Início da Análise 

Criação da geometria base (Parts) Definir Tipo de Elementos 

Atribuição das propriedades das 
seções das barras (Sections) 

Atribuição das propriedades dos 
materiais (Materials) 

Associação das Seções, geometria 
base, materiais... (Section 
Assignments) (Assembly) 

Aplicarção das condições de 
contorno 

Apoios (BCs) 

Cargas (Loads) 

Criação da geometria da malha 
(Mesh) 

Elementos cálculaveis pelo 
método dos elementos finitos. 
Aproximação da estrutura real. 

Definição das Variáveis de Saída 
(Field Output Requests) 

PROCESSAMENTO 
Solução, Cálculos 

Computacionais (Jobs)  

PÓS-PROCESSAMENTO Análise dos resultados 

Variavéis de saída 

Análise gráfica 



2.1. INÍCIO DA ANÁLISE 

 

 Se você ainda não iniciou o programa Abaqus/CAE, digite cmd no 

Menu Iniciar para abrir o Prompt de Comando e nele digite 

abq6122se cae para executar o Abaqus. 

 Em Create Model Database na caixa Start Session que aparece, 

selecione With Standard/Explicit Model. 

 

2.2. PRÉ-PROCESSAMENTO 

 

 No menu Model à esquerda, clique com o botão direito em Model-1 e 

selecione Rename. Digite Chaminé. 

 No menu Model à esquerda, dê duplo clique em Parts, no campo Name 

digite Chaminé, e selecione as opções: 3D, Deformable, Shell, 

Planar. Em approximate size digite 2. Clique em Continue... 

 

 

 Clique em Create Lines: Rectangle (4 lines) na caixa de ferramentas e 

insira as seguintes coordenadas 0,0 – 0.6,0.6 – 0.2,0.2 – 0.4,0.4. Em 

seguida, desative a função Create Lines: Rectangle (4 lines) e clique 

em Done. 



 

 

 Na caixa de ferramentas, clique em Partition Face: Sketch. Selecione 

a aresta externa direita. Na caixa de ferramentas selecione Create 

Lines: Connected e através dela particione a chaminé como na 

imagem. Clique em Done. 

 

 

 No menu Model à esquerda, dê duplo clique em Materials. Na janela 

Edit Material. Selecione Thermal>Conductivity e digite 1.4 em 

Conductivity. Clique em OK. 



 

 

 No menu Model à esquerda, dê duplo clique em Sections. No campo 

Name: digite SeçãoChaminé, em Category selecione Shell, e em 

Type selecione Homogeneous. Clique em Continue...  

 

 

 Na janela Edit Section, digite 0.02 em Shell thickness: Value:, e 

clique em OK. 



 

 

 No menu Model à esquerda, abra Parts>Chaminé e dê duplo clique em 

Section Assignments. Selecione a chaminé por inteiro e clique em 

Done. Clique em OK. 

 

 

 No menu Model à esquerda, abra Assembly, dê duplo clique em 

Instances e clique em OK na janela Create Instance. 



 

 

 No menu model à esquerda, dê duplo clique em Steps. Digite 

Transferência de Calor no campo Name: e selecione Procedure type: 

General>Heat transfer. Clique em Continue... Na janela Edit Step, 

marque Steady-state em Response: e clique em Dismiss no aviso: 

“Deafult load variation with time has changed to Ramp linearly over 

step.”. Clique em OK. 

 

 

 No menu model à esquerda, dê duplo clique em Loads. Na janela 

Create Load selecione o Step Transferência de Calor, em Types for 

Selected Step selecione Surface heat flux e clique em Continue... 



 

 

 Selecione toda a chaminé, clique em Done e então em Brown. Na 

janela Edit Load, digite 20 no campo Magnitude: e clique em OK. 

 

 

 No menu model à esquerda, dê duplo clique em BCs. Na janela Create 

Boundary Condition, altere o campo Name para Temperatura Externa, 

Step para Transferência de Calor e Types for Selected Step para 

Temperature. Clique em Continue.... 



 

 

 Selecione as arestas externas e clique em Done. Digite 303.15 no 

Campo Magnitude na janela Edit Boundary Condition e clique em 

OK. 

 

 

 Repita para criar a condição de contorno da Temperatura Interna que 

possui magnitude de 373.15. 



 

 

 Na barra de contexto, em Module, selecione Mesh, e em Object, 

selecione Part. Na barra do menu principal, clique em Mesh>Element 

Type e selecione com o mouse toda a chaminé. Clique em Done, 

Abrirá a janela Element Type. Em Family, selecione Heat Transfer e 

em Geometric Order, selecione Linear. Clique em OK. 

 

 

 Na barra do menu principal, clique em Seed>Part e altere approximate 

global size para 0.04. Clique em OK. 



 

 

 Na barra do menu principal, clique em Mesh>Part. Aparecerá a 

pergunta “OK to mesh the part?”, clique Yes. Perceba que a Chaminé 

fica na cor azul. 

 

 

2.3. PROCESSAMENTO 

 

 No menu model à esquerda, dê duplo clique em Jobs e clique em OK. 

Abra Jobs (1), clique com o botão direito em Job-1 e clique em 

Submit. Nas janelas que se abrem, clique em OK e em Yes. Aguarde.  



 

 

2.4. PÓS-PROCESSAMENTO 

 

 No menu model à esquerda, em Jobs, clique com o botão direito em 

Job-1 e clique em Results. Na caixa de ferramentas, clique em Plot 

Contours on Undeformed Shape. 

 Na barra de ferramentas no canto superior à direita, selecione 

HFL>Magnitude. Na barra de menus principal, clique em 

Viewport>Viewport Annotation Options... Na janela aberta, selecione 

a aba Legend. Clique em Set Font. Na nova janela, altere Size para 

14. Clique OK nas duas janelas abertas. 

 



 Na caixa de ferramentas, clique em Plot Symbols on Undeformed 

Shape. 

 

 

 Na barra do menu principal, clique em File>Save As.... Dê um nome ao 

arquivo e clique em OK (É possível também salvar o arquivo com os 

resultados já calculados - job-1.odb). 

 

Determinação do campo de tensões gerado pela variação de temperatura 

interna e externa 

 

Muitas vezes estamos interessados em obter o campo de tensões do corpo 

gerado pelo campo de temperaturas devido a diferença de temperatura interna 

e externa. Temos um problema "termo-elástico" para solucionar. O programa 

ABAQUS nos permite solucionar o problema. A solução desse problema 

envolve a execução dos mesmos passos do problema apenas térmico, 

seguindo os passos a seguir: 

 

 Altere Material-1, adicionando as características: 

Mechanical>Expansion [Expansion Coeff alpha = 1E-5] e 

Mechanical>Elasticity>Elastic [Young’s Modulus = 2.1E9 / Poisson’s 

Ratio = 0.15] 

 Recrie Step – Type: Coupled temp-displacement 



 Recoloque as Temperaturas externa e interna (BCs) – Type: 

Temperature 

 Recoloque a condição de fluxo de calor (Loads) - Type: Surface heat 

flux 

 Apague a malha anterior e recrie uma nova malha de elementos (Mesh) 

– Mesh>Element Type: Family: Coupled Temperature-Displacement, 

Geometric Order: Linear. 

 

 Reprocessamento. 

 



 


